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 Focus on Your Goals 
Before you begin to learn or use any technological tool, you must have a clear idea of what you 
hope to gain by using it. Either the technology should make your life easier in some way and 
give you more time to focus on other aspects of your teaching, or it should improve some 
aspect of your teaching to such a degree that any extra work will be worth it.  

In either case, if you know what you want to get out of a technological tool before you start 
using it, it will be easier to focus on the essential features and not get distracted by unnecessary 
bells and whistles. As soon as you discover that a tool isn’t useful to you, drop it. 

  

Initial questions to consider: 
1. What are some concepts in your class that students consistently struggle to understand? 

2. What are the logistical aspects of teaching that you feel take up too much time or attention? 

3. What are the technologies you have found easiest to use or most useful? 

4. What are the technologies you have struggled with the most? 

5. What technologies  do you think will make the most difference to your teaching ? 
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 Student Expectations 
Students can be very calculating when allotting time to their academic work. Depending on the 
nature of the class, there are sure to be a number of students who are constantly figuring out 
how much work they need to do to get the grade they want (whether it be an A or a D). When 
you introduce a new technology, the degree that the students embrace it is directly related to the 
value that you place on it, both in terms of grading and your attention. 

Consider student motivations.  
Who are your students? What do they want to get out of this class? Compare these motivations 
with your own goals. What are the main points they need to understand? By positioning 
technologies relative to the students’ motivations (good grades, future jobs) you can draw them 
into using the tools and use the tools to meet your goals. Small classes filled with enthusiastic 
majors will require one approach, giant gen-ed lectures with a high percentage of reluctant 
students will require another.  

Give a grade for using it. 
Whatever the technology, from using simple links to online discussions, the way to ensure that 
a tool is used by your students is to grade them on its use. Students have told us that they do not 
spend time on “supplemental” or optional items. Students use some technologies because they 
see them as helping with graded elements such as preparing for exams, working on 
assignments, or writing papers. Other tools need to have a more obvious relationship to a grade 
(such as a participation score for online discussions or PRS answers). 

Show that you value it.  
If you show support for the use of a tool, your students will get the message (the reverse is also 
true). If you expect students to spend significant time outside of class using a tool, be sure to 
acknowledge its use in class or in personal comments to the students. In addition to grades, this 
will let the students know that you are paying attention to what they do with the tool.  

Be specific about what you want them to do with it 
In your syllabus or assignment sheets, be exact about what you want your students to do with 
the tool. If you want students to participate in online discussions, lay out in writing how many 
posts you want to see per week and what form they should take (original thoughts, responding 
to others, multiple lines, etc.). Students need specific guidelines or they will let things slide. 
Tools such as SPARK can include grading rubrics and assignment goals that help communicate 
your expectations and standards. 
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 Managing the Technology 

Useful Skills to Cultivate 

Typing 
If you can type fast, you will be more comfortable with the text-based aspects of teaching 
technologies (email, discussions, etc.). Free typing tutor programs can help speed you up. 

File Management 
Knowing where you have saved a file makes a big difference (especially when creating Web 
sites). If you often lose track of files, take the time to learn the file system on your computer. 

Have a backup plan 
Always prepare an alternative in case the technology fails. Print your slides. Have a handout. 
Plan for paper-based activities.  

Keep regular backups of files 
Magnetic storage is delicate. Disks, drives, servers, and other devices can fail or be destroyed. 
Always keep more than one copy of a file. The more important the file, the more copies you 
need and the greater the distance you should have between them. 

Purchasing and Learning the Right Tools 
Try the software before you invest time and money. OIT Computer Classrooms and the 
Learning Commons, have large collections of software. If you would like a demonstration, 
consultants in the Instructional Media Lab would be happy to show you how something works. 

Software Discounts through OIT  
OIT has many software packages that are available as site licenses or at steep discounts. Before 
buying anything at full price, check the OIT Software page: URL 

Faculty Workshops from Academic Computing 
OIT Academic Computing offers regular workshops on many software packages. Most are 
offered in January and June, but departments can also request special sessions if enough people 
are interested in a specific topic. 

Basic Troubleshooting 

Test, Early and Often 
Do what you plan to do with the tool as many times as you can before you do it in class. It is 
especially important to test on the actual equipment you or your students will be using. 

If it doesn’t work, try again  
Sometimes the failure will not repeat itself. Step back (restart if necessary) and try again. If a 
problem is “reproducible” every time, it is easier to solve. 

Check the simple stuff first 
Even geeks forget to plug things in. Check all the easy solutions before you try complex fixes 
or get discouraged. Run through the basic set up instructions again. 

Don’t assume it is your fault  
Do not dwell on what you may have done wrong, look for why the computer is being stupid. 
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 Links to Online Resources 
Students currently arriving on campus have already spent years using Google or Wikipedia as 
their primary research tools. With all the questionable resources on the Internet, one of the most 
important resources faculty can give their students is a list of reputable online resources and 
some guidance on how to judge the resources that they find through their own searches. 

Library Subject Specialists 
The library is the best place to send students for reputable sources. Subject Specialists maintain 
general purpose Web pages for their subjects and can create more specific guides on request. 
To locate your subject specialist, see: http://www.library.umass.edu/reference/contactal.html 

A list of existing subject guides can be found at: 
http://www.library.umass.edu/subject/ 

Information for students about using online library resources: 
http://www.library.umass.edu/instruction/students.html 

Online Books and Journals 
The library subscribes to millions of dollars worth of online journals and other online resources. 
When you find an article you want your students to read, it will likely be available through one 
of these services. To make a link to the article, find its online citation and copy the “persistent 
link” into your handout or Web site.  

If your students will be coming from off-campus networks, they can still access the link if you 
paste the following code in front of the URL:  

http://silk.library.umass.edu:2048/login?url= 

For more details about this process, contact your Subject Specialist, or see the Library’s own 
documentation at: http://www.library.umass.edu/instruction/faculty/linkguide.html 

Searching and Evaluating Web Sources 
If you want your students to use Web-based resources, but learn how to search better and find 
more reputable information, you may need to help them get past the simple Google search. 

Advanced Google Searches  
The simple search on Google is great for finding the most popular links on a topic, but this is 
not always the best source for information (especially if the topic is related to pop culture 
icons). Recommend that your students use the Advanced Search and refer to the Search 
Features page at: http://www.google.com/intl/en/help/features.html for interesting tricks such 
as limiting searches to specific sites (site: ) or specific kinds of files (filetype: ). 

For more on Advanced Google searching, see the handout at: 
http://www.oit.umass.edu/workshops/tutorials/google_techniques.html 

Evaluating Sites 
The library is a good source for educating your students about evaluating the sites that they use 
in their research. A good basic tutorial is available through the Library at: 
http://www.library.umass.edu/merlin/html_docs/mod6/mod6page1.html
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 Handouts  

Tips for making handouts in Microsoft Word  

Insert information on every page in the Header and Footer. 
Go to View > Header and Footer to open a separate view of the document that allows you to 
add items that will appear on every page. The header and footer toolbar has tools that insert 
page numbers, dates, times and other special footer content. We recommend adding 
institutional and personal information to every page in case a particularly useful page gets 
distributed separately from the rest of the document.  

Use styles to more efficiently control text formatting in a document. 
Go to Format > Style to create standard formatting rules for headers, subheads, body text and 
other elements of the page. When applying styles, you select the text and select the appropriate 
style from the “Styles and Formatting” tool bar at the top or the “Formatting Palette” on the 
right (depending on version and operating system).  

If you change the look of a style later, these changes will be applied retroactively to all the text 
in the file. Styles take a bit of work to set up, but they make formatting much easier. 

Add more than just text to your document. 
Go to the Insert menu for inserting all kinds of elements in your document. The first part of the 
menu includes short cuts for inserting page break, date, time, and even customized phrases 
(tired of typing out the name of your organization?). The middle part contains footnotes, 
captions and other standard elements of a document. The last section is for adding visual 
elements, from pictures (see page on digital images for details on preparing pictures), to 
movies, to “objects”. Objects are links to elements created by other Microsoft Office programs 
which can then be automatically updated from those programs. For instance, a graph object 
from Excel can be displayed in a Word file, but when the data in Excel is updated, the graph 
will update automatically when the Word file is opened. 

Tips for making handouts in Microsoft PowerPoint 

Use “Handouts” option when printing to print several slides per page 
By default, PowerPoint prints one slide filling each page. However, if you change the “Print 
What” settings on the Print dialog box you can print multiple slides on each page (2, 3, 4, 6, 
and 9 slides per page). Note that printing three slides per page gives you lines in a secod 
column for taking notes.  

Use “Notes” option when printing to print each slide plus notes per  page. 
In addition to printing “Handouts”, you can set PoowerPoint to print the “Notes” view of your 
presentation. This will split the page in half—with the slide at the top and the notes on the 
bottom. By editing the “Notes View” of your presentation, you can even craft exactly how this 
page will appear, including adding graphics and diagrams. 

Printing the notes view can provide easy lecture notes, or an annotated version of the talk that 
you can hand out or post in PDF form on a course site. 
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Distributing Handouts without Paper 
It is possible to distribute original Microsoft Word (.doc) or PowerPoint (.ppt) files to students 
or colleagues. Distributing files like this  can be useful if you want to use the notes or tracking 
changes features of Word. A disadvantage of this is that your students or colleagues will need 
to have the right software to open the file, and if you have used any special fonts they will need 
these as well. 

If you want to send files to students or colleagues without worrying if they have the right 
software, here are two popular options: 

Save as PDF to preserve formatting and fonts 
Adobe Acrobat’s Portable Document Format (PDF) is a file type that can be read on any 
computer that has the Adobe Acrobat Reader installed (most browsers come with this installed 
or it can be downloaded from http://www.adobe.com/products/acrobat/ readstep2.htm). The 
benefit of saving your files as PDF is that it preserves the formatting of the page, graphics, 
fonts, special symbols or equations.  

To create a PDF, you have to purchase the full version of Adobe Acrobat (the Reader is not 
enough). If you do not have access to this version of Adobe Acrobat on your computer, it is 
available on all of the computers in the OIT Computer Classrooms, the Learning Commons, 
and in the Instructional Media Lab. 

Once Acrobat is installed, when you select “Print” in MS Word (or other software) you will be 
able to select “Adobe PDF” from the list of printers. By printing to a PDF file you capture what 
would have gone to the printer in a file that can be emailed, saved on a disk, or posted on a 
Web site.  

For more details on creating PDFs, see the PDF workshop handouts to be posted soon at: 
http://www.oit.umass.edu/workshops/tutorials/  

Save as HTML to post for easy viewing on a Web site 
Microsoft Word (and most other word processing software) has an option for saving any 
document as an HTML file. The resulting .html file can be posted on the Web as a page. The 
benefit of this is that the file will open immediately in the browser window (as opposed to .doc 
or .pdf files which need to be downloaded and opened in separate software.) This is most useful 
for simple files that need to be quickly accessed by students – such as syllabi, schedules, or 
assignments. 

A disadvantage of converting a word processing file to HTML is that many basic formatting 
elements do not translate to HTML: the most significant being tabs and multiple spaces. When 
you save a file as HTML, it is best to check it in a browser to make sure that the file looks the 
way you want it to look. It may be necessary to reformat the file before posting it. 

For more details on saving Word files in HTML, see the Converting Word to HTML handout 
at: http://www.oit.umass.edu/workshops/tutorials/webdev/general/word-to-html.html 
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 Creating Presentations  
PowerPoint is likely the most common use of technology in the classroom. It is very simple to 
use (and mis-use).  

Useful Tips for using PowerPoint 

Use different views for different tasks. 
PowerPoint has several ways to view and work with your presentation:  

Normal – for editing individual slides 
Slide sorter – for seeing and organizing the entire slide show.  

Slide Show – displays the slide show on your computer screen. 

Notes view – displays each slide on a page with room to write notes.   

Use a Master Slide to control the design of your show,  
To access the master slide, go to View > Master > Slide. Make changes in this view and all of 
your slides will have the same color scheme, fonts, etc. If you later decide to change the master, 
this change will appear on all the slides. If you want a single slide to look different from the 
master, simply make changes directly on that slide. 

Controlling a Presentation 
When you are showing a presentation in Slide Show mode (Slide Show > View Show)  
you can: 

a. Use the arrow keys on the keyboard to change slides:  to go forward,  to go back. 

b. Press the Alt key and press Tab (Option-Tab on Mac) to switch between the 
presentation and other programs or files you have open on your computer.  

c. Move the mouse to the lower left of the screen to access an on-screen menu that allows 
you to jump to specific slides, blank out the screen, or access a “pen” to mark up slides. 

d. Pres the “Esc” key to end the presentation. 

Printing Presentation Handouts 
You can print your presentation in a variety of formats. Simply select the style you want when 
you print: “Slides” prints one slide per page, “Handouts” prints multiple slides per page (2, 3, 
6, or 9), “Notes” prints the slide at the top of the page and the notes at the bottom. 

Tips for Good Presentations 
Simply writing what you will say in a bullet list and reading it off to your students is not the 
best use of PowerPoint. Ideally, the students will see each slide as the introduction to a new 
point you are about to make. The slide will raise questions in their minds which you will help 
them answer (either directly or indirectly). Good alternatives to bullet points are: questions, 
quotes, graphs, data sets, tables, images, incomplete diagrams (or formulas), video segments, 
audio tracks, etc.  

For more about Powerpoint, see the workshop handout at: 
http://www.oit.umass.edu/workshops/tutorials/ppt_basics.html 
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 Digital Images 
There are many ways to capture an image into digital form: digital cameras (even in phones), 
scanners, and even Internet searches. Try to get the best quality image you can get, then save 
copies of this image to match what you need for your medium: printed document, slide 
presentation or Web site.  

If you copy an image, be sure to get permission from the copyright holder or verify that your 
limited use falls under fair use guidelines (see the page on Copyright for more details). 

Finding Images Online  
Google’s Image Search makes it almost too easy to find pictures on the Web. Each picture that 
comes up in the search contains size and format information (helpful when looking for the best 
quality version of an image). 

Flickr also provides access to images posted by individuals. For some subjects, this can 
provide an interesting collection of image; some of which will be available to use under less-
restricted copyrights. 

For more on Google image searching, see the handout at: 
http://www.oit.umass.edu/workshops/tutorials/google_techniques.html 

Get a high-quality image to use as your source.  
Digital images are made up of tiny boxes (pixels) of color. The number of pixels across 
(typically given in pixels-per-inch) helps you determine the quality of the image. Your 
“original” source image should be as high quality as you can get (about 300 ppi). Keep this file 
untouched  and make copies at lower resolutions that are resized for a specific purposes.  

Size images properly for your purpose. 
Original digital images are likely to be too large for most uses. Adobe’s Photoshop or 
Photoshop Elements can resize images. Free image editors also come with most operating 
systems iPhoto on the MacOS or Microsoft Office Picture Manager on Windows. 

- Images in Word An uncompressed JPG file sized to the width of the page (or less) and 
no more than 150 ppi will look fine on most desktop printers. More than 150 ppi won’t 
look much different unless the file is printed on a higher quality printing press. 

- Images in PowerPoint A PowerPoint slide is 7.5 x 10 inches. An uncompressed JPG 
that is this size will fill the screen when projected (make it smaller if you want to add a 
caption). If you care about image quality, make the image match the resolution of your 
projector, most projectors project images that are 1024 x 768 pixels.  

- Images on the Web Generally speaking, an image file that is 500 pixels wide will take 
up most of a “page” on the Web. 150 pixels wide (or less ) is a good size for an image 
that will share space with text. Buttons should be fewer than 100 pixels wide. Use JPG 
for photos and GIF for flat images with only a few colors (like a line drawing). 

For more details about using digital images see the Digital Images workshop handout at: 
http://www.oit.umass.edu/workshops/tutorials/images_publishing/image_basics.html 
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 Digital Audio 

Recording Audio 
For best results, find a quiet space (listen for traffic or fans). A small space with soft materials 
on the walls will make cleaner audio. Depending on your standards, you can record usable 
sound with any sound recording device, and then load it on to a computer. We’ve had success 
recording audio-only with digital video cameras (which have high-quality microphones built-
in) and exporting the audio track from video-editing software such as iMovie.  

Audio Recording Tips: 
• Avoid distracting noises such as banging your hands on the table, shuffling papers, or 

touching the recording device.  Also try to make sure you will not be interrupted while 
recording. 

• Make your podcast casual but structured.  Don’t lecture or read your content and keep 
your podcast flowing. 

• Monitor the length of your podcast.  The best probable length is between 30 and 60 
minutes, nether too short nor too long.  You can always edit content in or out to reach 
the desired time. 

• To get a better sense of the format and the style of the average podcast, surf the Web or 
look in iTunes for podcasts you can use to get yourself familiarized with the medium. 

Editing and Saving Audio Files 
There are many programs available for editing audio files. Use one that can save MP3 files (the 
standard file format for audio podcasts). On MacOS, GarageBand comes free with the 
operating system. On MacOS, Linux or Windows systems, Audacity is available for free from 
http://audacity.sourceforge.net/. 

When you save your MP3 file, the settings you use depend on the file size and sound quality 
you want. If the audio content is primarily spoken words (or your listeners don’t have fast 
Internet connections) a lower “bit rate” such as 56k Mono will work fine. If you have some 
music or want higher sound quality consider 64k or more with Stereo. High-quality music 
should be saved as 128k Stereo. 

You might want to create a high-quality version of the recording as well as a low quality 
version so your audience can decide the quality that they want and can download based on the 
their Internet connection.  It is also a good idea at this point to create a backup of the original 
recording as well as any versions you create in an external media such as DVD or an external 
hard drive. To be completely safe, keep this backup in an entirely different location from your 
originals (keep work media at home and vice-versa). 
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 Digital Video 
Most cameras and computers sold these days have the basic capabilities necessary to capture 
and edit video. The trickier part is capturing video off of older media (such as VHS or 8mm 
film) and navigating the copy-protection and copyright rules of commercial footage.  

Shooting Good Footage 
If you are preparing to shoot your own video, here are a few tips that will help you make sure 
that you get the best quality footage for later editing. 

- Always stand the camera with its back to the sun, window, or other light source. 

- If you need audio from a single person in a crowded environment, attach a wireless 
microphone to them or use or a “shotgun” microphone. 

- If you can control the “stage”, carefully consider the foreground and background. Dress on-
screen participants in clothes that will contrast with the background (light on dark, dark on 
light). Keep unnecessary clutter out of view (i.e., pose people in front of a flat wall). 

- If compression matters (for email or Web), keep backgrounds flat and movements to a 
minimum (the less things move, the more the clip can be compressed.) 

Capturing and Editing Video 
If you are starting with video from a digital camera, all you need is a computer with a firewire 
connection and video editing software. For simple capture and edits use iMovie (comes with 
MacOS) or Movie Maker (comes with Windows XP). If you have long or complicated video 
projects, you should consider using Final Cut Pro on MacOS, or Premiere on Windows.  

To capture video off of an older “analog” source such as a VHS tape, you need to convert the 
footage to digital tape before you can capture it. If you have a digital camera that can connect to 
a standard VCR, you can do this yourself (make the digital copy off of the best quality tape you 
can find, each copy made from a VHS tape loses quality.) Once you have a copy on digital tape 
it can be captured on a computer and edited.  

If you don’t have access to this software or equipment, iMovie, Final Cut Pro and a variety of 
video and audio equipment is available for teaching-related work in the Instructional Media 
Lab. Contact the media lab at instruct@oit.umass.edu or 545-2823 to make an appointment. If 
you don’t already know how to use the equipment, we can show you how.  

Workshop handouts for Digital Video are currently being developed. Eventually they will be 
posted at: http://www.oit.umass.edu/workshops/tutorials/ 

Copyright Issues 
Unless you are working with footage that is yours or in the public domain, you will need 
permission before you can capture, edit or display other people’s footage. If you want fair use 
to apply, be sure that only your students to see the footage, use as little of the footage as you 
need to make your point, and then only when the footage is the subject of commentary or 
analysis. Capturing and using video for its original purpose (such as instructional videos) is 
typically not fair use and requires permission.  
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 Intellectual Property and Copyright (a summary) 

If you did not make it, you need permission to use it 
Copyright law states that creators (or copyright holders) have the right to control the 
distribution, duplication, and modification of their work. A work does not have to specify 
“Copyright somebody 2005” to be copyrighted. In fact, unless there is a statement explicitly 
granting you (or the public) rights to use an image or other creative work, you can’t use it 
without the permission of the copyright holder. 

Getting permission 
Getting permission is often as easy as sending an email or making a phone call. Many copyright 
holders are happy to grant permission to students or faculty who want to use their work in 
limited ways. When asking for permission, be clear about what you plan to do with the work 
and make sure the written permission you receive clearly states how you are allowed to use the 
work. Copyright law assumes that any use of a work not specifically granted is not allowed (i.e. 
if you have permission only to use an image on a poster, you can’t also use it on a Web site.). 
In many cases, copyright holders make it easy to ask for permission; for instance, slideshow 
rights for New Yorker cartoons can be purchased online for $19.95 at www.cartoonbank.com. 

Public Domain 
Works that are available for anyone to use or modify are in the “public domain.” This 
frequently includes older works, pieces created by the government, or any work a creator has 
specifically placed in the public domain. Note that reproductions or performances of public 
domain works are often copyrighted by the publisher or performer. In this case, you will need 
to get permission from them to use their version, or you will need to make your own copy 
directly from the original work. 

Fair Use 
Copyright law contains a (short) passage allowing the use of copyrighted works without 
permission for “purposes such as criticism, comment, news reporting, teaching (including 
multiple copies for classroom use), scholarship, or research” but that each use must consider 
the following factors: 

 (1) the purpose and character of the use  
(2) the nature of the copyrighted work; 
(3) the amount and substantiality of the portion used  
(4) the effect of the use upon the potential market for or value of the copyrighted work. 
In essence, fair use allows for you to use a copy of a work as long as you are commenting on it 
(in the case of reviews, journalism, or satire) or using a copy to further knowledge about the 
work (in the case of teaching or research). When the work itself is not the subject of what you 
are creating, or when your use will negatively affect the copyright holder’s ability to maintain 
their rights, the use is not fair. “Fair Use” is a defense you use after the copyright holder sues, 
so if there is any question it is best to consult a lawyer or get permission. 

For more details and resources on copyright see: 
http://www.oit.umass.edu/workshops/tutorials/copyright.pdf 
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 Classroom Technologies 
If you are interested in using technologies in the classroom, there are a variety of spaces and 
equipment that make it easy to include technologies while you are teaching. 

AV-Enhanced Classrooms 
The provost’s office is in the process of installing projection, video, and audio equipment in 
many of the general-purpose 30-90 seat classrooms across campus. These classrooms each have 
a ceiling-mounted projector, a screen, and a locked equipment box that includes a VCR, DVD 
player, microphones, and a switching system that allows you to project from one or two 
computers.  

Documentation and information about using the classrooms can be found at: 
http://www.umass.edu/provost/classroom/ 

Video Conferencing Classrooms 
There are several options for making a video conferencing connection on campus. For general-
purpose academic use, contact OIT Computer Classrooms to reserve time in the OIT Video 
Conferencing room. (note for Fall 2007: this service is being redesigned, be sure to contact us 
as early as possible about availability and schedules).  

For more information about the OIT Video Conferencing classroom see: 
http://www.oit.umass.edu/academic/video_conf/ 

Personal Response System (PRS)  
Classroom response systems such as PRS enable the instructor have every student in the class 
give an answer to a question. At its simplest, this can be used to provide the instructor with 
quick feedback on how many students understand the material, or show the audience how their 
answers to a survey-style question matches up with the rest of the class. More complex uses 
include collecting numeric data from students and facilitating quizzes or exams. 

On campus, most of the large lecture halls and AV-enhanced classrooms have PRS-brand RF 
receivers. If you plan to use PRS, you will have to require the purchase of a “clicker” by each 
student in the class (sold in the Textbook Annex). In departments where clicker use is common, 
students may already own clickers.  To receive results from the clickers, the you need to load 
the PRS software on your computer and connect it to the receiver in the classroom. Data from 
the clickers can be managed in the PRS software or exported to Excel, OWL and SPARK. 

For more information about PRS on campus see: 
http://www.umass.edu/prs/  

Tablets and Schoolpads 
Many faculty on campus have begun to use Tablet PCs, Schoolpads and other devices in the 
classroom to enhance their lectures. The UMass Amherst Tablet PC Community of Practice 
meets regularly during the school year to discuss and share experiences with this new 
technology.  Contact Mei-Yau Shih in the Center for Teaching to find out more: 
mshih@acad.umass.edu. 



 
Overview of Teaching Technologies 

OIT Academic Computing, University of Massachusetts  http://www.oit.umass.edu/academic           070821fz 
        

14 

oit 

 OIT Computer Classrooms 
The OIT Computer Classrooms provide teaching spaces for faculty who need their students to 
have access to computers during class meetings. Some classes meet in the OIT Classrooms for 
just one or two sessions (to introduce students to a particular piece of software or give an 
exam), some for the entire semester. We have both PC and Mac classrooms, and offer access to 
an extensive collection of software. When not being used for teaching, students, faculty and 
staff have access to the Computer Classroom facilities. 

The OIT Computer Classrooms also manages several specialized facilities on campus, 
including the Five College Video Conferencing Classroom, the Digital Video Editing 
Classroom and the Assistive Technologies Center. The new Learning Commons on the Main 
floor of the W.E.B. Du Bois Library has 100 PC and Mac computers available 24/5 with the 
same software as in our other classrooms.  

What do I need to use the OIT Computer Classrooms? 
Both faculty and students need their NetID and UMail password to log into OIT Classroom 
computers (until Spring 2008, some may still require a UMAccess password). In order to use 
our pay-for-print system you will need to have a debit account associated with your UCard or a 
guest UCard. Guest UCards are available in a variety of locations on campus. 

Work cannot be stored on OIT Classroom computers, so be sure to bring a blank CD-RW or a 
USB drive to save your work. Some classrooms will allow you to use a floppy disk or a zip 
disk as well. 

Where are the OIT Computer Classrooms located? 
Windows 
 Fine Arts Center 444, Goodell 613, LGRC A110a  
W.E.B. Du Bois Library (Calipari Room, 720, 1667) 
Bartlett 101 & 105 (Writing Program -- this classroom is generally unavailable for public use.) 

MacOS 
LGRC A110, LGRC A127 (Digital Video Editing Classroom – access is limited) 
W.E.B. Du Bois Library 767 

Learning Commons 
W.E.B. Du Bois Library main floor has both PCs and Macs.  

Assistive Technologies Center 
W.E.B. Du Bois Library main floor, has special equipment and software for use by students 
with disabilities who need special accommodation to use computers.  

Kiosk Locations (Web-browsing only)    
Web kiosks are available in LGRC, Whitmore, Thompson, and Goodell (6th floor). 

 

See next page for information on reserving and using computer classrooms. 
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Reserving an OIT Computer Classroom 
Faculty or instructors may reserve a computer classroom if your students need access to 
computers during class time. We will always do our best to accommodate your class even with 
late notice, but our facilities are limited, so we urge you to get your requests in early! We prefer 
two weeks notice for single session reservations. We ask that the faculty member or TA be 
present throughout the class session. 

Most of our classrooms can accommodate 20 students; one classroom (Du Bois 1667) has an 
additional 10 computers in a side room to accommodate larger groups. Data projectors are 
available. If you need access to one, let us know when you make your reservation. 

For more information or to make a reservation 
If you need more information about teaching in the OIT Computer Classrooms or wish to make 
a reservation, contact Kate Hudson, Manager, OIT Computer Classrooms, 
khudson@oit.umass.edu, 545-1706. 

Software 
OIT maintains an extensive collection of software in the OIT Computer Classrooms. If you 
would like to see additional specialized software that you are using for a course installed on our 
OIT Computer Classroom machines, we will do our best to accommodate you. If there is a 
licensing fee associated with the software, the department requesting the software is usually 
responsible for paying the licensing fee. 

We encourage you to contact us early for a preliminary consultation, even if your plans are not 
completely finalized. Contact Kate Hudson, Manager, OIT Computer Classrooms, 
khudson@oit.umass.edu, 545-1706. 
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 Public Course Sites 
There are a variety of ways to post course information online. The tool you choose depends on 
the features you most need to meet your goals. First you must choose if you want a site that is 
available without restrictions (a public site) or a site that is limited to the students who are 
registered for your class (in this case, consider SPARK). 

Request an additional account for your course 
Each OIT account for students, staff and faculty comes with a variety of services that can be 
used for personal (but not commercial) purposes. Faculty can request an additional account for 
each course they teach, so that these services can be used specifically in each course. 

OIT Account Services include: 
• UMail email account with a separate address for the course. 
• UDrive online file storage space for posting and sharing files. 
• UMass Blog software for creating and maintaining a simple announcement-oriented site. 
• Web hosting space (100 MB) for creating more complex, custom Web sites.  

To request an additional account for a course, fill out the form at: 
http://www.oit.umass.edu/academic/course_sites/  

UDrive: for simple file sharing 
The UDrive service gives you (and your students) online file storage. By default, this space is 
private, but files and directories can be shared with individuals, groups, or the public. If all you 
need is a no-frills space to post handouts and assignment files, UDrive is a good option. 

UMass Blogs: for simple course sites 
Blogging software makes it easy to maintain a simple site. You choose from a set of 
customizable designs and post announcements using an online form. You can also post static 
pages (such as a syllabus), links, files and images. Additional tools let you allow students to 
comment on posts or contribute their own. A blog gives you everything you need for a simple 
course site, plus extra features, without much effort. 

Web Hosting: for customized course sites 
Web hosting gives you an empty space and lets you build a site from scratch. The URL will be 
http://courses.umass.edu/course###. You can write HTML code yourself or use software such 
as SeaMonkey (free) or Dreamweaver (commercial) to build, post, and maintain your site. This 
process requires attention to detail and technical proficiency, and is not for everyone. 

For a starting template and instructions on how to build a site from scratch see: 
http://www.oit.umass.edu/workshops/tutorials). 

Note about Copyright and Public Sites  
“Fair Use” rules that allow use of copyrighted materials in a classroom or on a password-
protected site do not allow posting of material on public sites. Because public sites are open to 
anyone, you must get permission before posting anything that you did not personally create or 
that is not explicitly in the public domain.  
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SPARK Course sites 
SPARK courses are based on the Blackboard Vista Learning Management System formerly 
known as WebCT. A Learning Management System (LMS) provides an easy way to post 
course content on a site, and provides a collection of tools that allow for a variety of learning 
activities to be performed in an online environment. Such activities include written 
“discussions”, online quizzes, drop boxes for assignments, and live chats. 

When you request a SPARK course, you get a basic framework of a site and can add content or 
tools as needed. The interface is simple, and Web-based. This course can be used as a 
companion to existing course sites such as a blog.  

Request a new SPARK course account. 
Instructors can request a course account in SPARK for any course that they teach using the 
form at: http://people.umass.edu/accoprod/webct/vista4_request_course.html. 

Once the site is created, you will use your OIT NetID and UMail password to log in to SPARK 
at http://www.oit.umass.edu/webct/. When you log on to SPARK, you will see links to your 
courses listed on the “My Blackboard” entry page. Click a link to access the course. 

Only registered students can access the site. 
SPARK rosters are automatically updated with data from the registrar each morning. When 
students log in to SPARK, they use their own OIT NetID and UMail password. If a course for 
which they are registered is using SPARK, the link will appear on the initial page.  

Build by modifying a template with browser-based tools 
A newly created SPARK site comes with a basic framework for a course site. You can add and 
remove tools using a simple “select item, click action” Web interface. Course content can be 
added by uploading files to the site. Links to these files can be added to the home page as icons 
or as links within many of the available tools.  

SPARK sites are flexible and expandable. 
SPARK sites can contain just a few documents and a syllabus. SPARK sites can also contain 
interactive elements that allow students to perform tasks such as take quizzes, submit 
assignments, and debate topics outside of class. What you do depends on your goals and how 
much time you have. Some tools are easy (making links, posting files). Some tools take work 
up front, but then pay off during the semester (quizzes, learning modules). Other tools are easy 
to activate, but require work during the semester (discussions, chat, drop boxes).  

Student Rosters and Grading in SPARK 
Student rosters in SPARK are updated daily with data from the Registrar. This includes first 
name, last name, SPIRE ID (UMass ID), OIT NetID (User ID), UMass email address and much 
more. All of this data can be easily downloaded for use in your own data-management 
software. Data can be uploaded to SPARK as long as it includes the OIT NetID as a key.   

The Grade Book tool can also be used to keep track of student information and grades. You can 
create custom columns, have grades from online quizzes entered automatically, and calculate 
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 grades with data from several columns. Grades can be released to students securely (a student 
will only see his or her own grades). On request, you can have final grades transferred from 
SPARK to SPIRE for approval at the end of the semester.  

Controlling Access to Specific Content or Tools 
SPARK lets you control access to tools and course content in minute detail: 

- who can access (by group or individual) 

- when they can access 

- by specific criteria (such as grades or other data) 

 This lets you prepare content ahead of time, but only release it when it is needed. It also allows 
you to limit (or encourage) self-paced students who want to work ahead. 

Features and Functions of a SPARK site 

Basic Site Structure and Navigation Included 
SPARK sites come with a basic framework of a site. As you add content and modify the 
framework, you do not need to keep track of modifications to the navigation. Essential 
navigation (headers, course menus, breadcrumbs, etc.) is all updated by the software when 
needed; you just add the content. 

Posting Course Content 
Links to outside URLs and files uploaded into SPARK can be added easily. Single files can be 
HTML, PDF, TXT or any file format that your students can read through a browser. (PDF is 
the best format for PowerPoint shows.) 

Organizing Course Content  
Large collections of links or files can be grouped in folders or within “Learning Modules”. 
Learning Module pages have an added benefit that they can be interlinked with other tools and 
student access to the pages is tracked in extreme detail. 

Surveys and Quizzes 
Quizzes, exams, self-tests and surveys can easily be created in SPARK. As you build these 
“assessments”, you build a pool of questions (multiple choice, true/false, matching, short 
answer, long answer, etc.). Quiz settings allow you select random sets of questions, set proctor 
passwords, limit access to a specific lab on campus, and control the timing of access down to 
the minute. Results can be released to the students with comments. Grades of automatically 
graded portions can be loaded into the grading module automatically.   

Simultaneous Communication  
SPARK contains a built in “chat” tool in which students can type messages or draw pictures in 
real time. These live “conversations” can be recorded for future reference. 

Bulletin Board Discussions 
SPARK contains a bulletin board-style system in which students and faculty and post written 
comments and responses based on an initial topic posting. Users log in when they can and 
respond to the messages that have been posted before. This tool includes a “blog” variation for 
commenting on specific posts and a “journal” variation which provides each student with a 
“private” thread that only the instructor can read.  
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 Email and Email Lists 
The messages in SPARK’s “Mail” tool are only visible within SPARK (messages can be 
individually forwarded outside, but this can cause confusion). Some faculty and students prefer 
this to keep course-related message traffic out of their personal emails. Others prefer that the 
messages come to them where they usually check for mail. It depends on your preference. 

Calendar and Announcements  
A basic calendar is included in SPARK that you can use to post significant events and links to 
posted files. New entries appear in a popup when students first enter the site. Major University 
dates are automatically posted for each semester. Students can post their own events, privately 
or (if allowed) publicly. 

Syllabus  
The syllabus tool in SPARK can be used to create a syllabus from a template, or can be set to 
use an uploaded file (HTML or PDF as needed). 

Assignments 
The SPARK assignment tool creates a place where students can view details about an 
assignment, download starter files, and upload their final work. This tool displays and tracks 
due dates, and can be set to block or mark late submissions. Any type of file can be uploaded 
(within reasonable limits of size and upload speeds). Instructors can then use the tool to post 
grades and comments back to the students. 
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 OIT Services for Students 
All students at UMass Amherst are required to have an OIT account. This account comes with a 
variety of services that many students do not even know they have.  

Access to the Internet 
On-Campus, students can access the Internet via Ethernet from most campus buildings and all 
of OIT's classrooms and labs. Wireless access is available in an ever-growing number of 
buildings and outdoor locations on campus. All scheduled classrooms have wireless access. 

Off-Campus, most student’s now have personal high-speed Internet access. Students without 
high-speed access can connect to the Internet via OIT’s 56k modem service. 

Email 
OIT's primary email system is called UMail. All students are required to check their official 
email accounts (@student.umass.edu) for official communications from the University. If you 
want to create a mailing list for your classes, such a service is now available through SPIRE. 

UMail can be accessed using most IMAP-compatible email programs (such as Outlook, 
Netscape, or Thunderbird) or through the Web at umail.oit.umass.edu. Students have 30 MB of 
storage for email, faculty and staff have 100MB. 

UDrive 
Every OIT account comes with 250 MB of storage space that can be accessed via the Web or a 
WebDAV connection. Files and folders in this directory are private by default, but can be made 
public or shared with specific individuals or groups. http://www.oit.umass.edu/udrive/. 

Blogs 
By logging on to blogs.umass.edu, students can create their own personal blogs. These blogs 
can be used to post entries about their coursework, opinions, or personal lives. Blog entries can 
include embedded images, video, or audio. Comments on posts can be allowed and managed by 
the blog owner. Each blog creates an RSS feed that others can use to track new posts. 

Space for a personal Web site 
Each OIT account is allocated 100 MB of file space which may be used to store files for a Web 
site. Students can use this space to post personal pages or pages related to their academic work.  

Access to public computer labs, classrooms, and email kiosks 
OIT maintains computer classrooms on campus which are accessible to faculty, students, and 
staff with an OIT Account. Several classrooms are in LGRC lowrise and the W.E.B. Du Bois 
Library; others are in buildings across campus. 

Access to SPARK courses 
When students are enrolled in a class that uses SPARK, they use their NetID (OIT Account 
user name) and UMail password to get access to SPARK. For detailed information about 
SPARK, see the SPARK Web site at http://www.oit.umass.edu/webct/campus-vista/. 

Remote access to library databases 
If a student is coming from an off-campus network to view online materials offered through the 
library, they will be asked to enter their OIT NetID and UMAccess Password before being 
passed through to the materials.   

For more details about OIT accounts see: http://www.oit.umass.edu/accounts/ 


